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Copyright
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Contacts and Support

For resolutions to common issues, answers to frequently asked questions and hints and tips for using our products:
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Introduction
Finland Address Data Information

Dataset Code: FIN

Approximate Data Size: 12MB

Data Source: Finland Post Ltd

Update Frequency: Bi-monthly

The data release dates are:

l February

l April

l June

l August

l October

l December

Expiry: Data files will expire 13 months after creation.

Ensure every data update is applied promptly, otherwise the data may
expire and the product will become unusable.

List Of Available Data Files

File Extension File Type Comment

.dts Dataset Main address data.

.zlx Single Line Index File Indexing data for use with Single Line searching.

.tpx Typedown Index File Indexing data for use with Typedown searching.
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About This Data
This chapter provides detailed information about the FIN dataset.

Area Covered
The FIN dataset covers all street and post office box addresses in Finland.

Address Elements
The following address elements are stored within the FIN data files.

Address Element Example Element Code

PO box number 12 B11

Finnish street Saarankatu S11

Swedish street Saragatan S12

Building number 34 P11

Postcode 40800 C11

Finnish locality Helsinki L21

Swedish locality Helsingfors L22

Finnish municipality* Espoo L11

Swedish municipality* Esbo L12

Municipality code* 049 L13

Country* Finland X11

Two character ISO country code* FI X12

Three character ISO country code* FIN X13

* Elements that only appear in the address if their position is fixed.

Address Element Definitions

Postal Code Structure

A postal code in Finland consists of a five-digit number, and typically covers a single locality. For example:

68910 PÄNNÄINEN

The place name is commonly written after the postal code, on the same address line.
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Forms Of Address

Forms of address are referred to as Country Views in Pro version 6 and earlier.

There are two Forms of address stored in the Finland data files:

Form of address Information Source

1 CDF for Finland Addresses returned in Finnish

2 Swedish-language Addresses returned in Swedish

These provide alternative language versions of Finland addresses. On occasions when the Swedish Form of address is
selected and no Swedish equivalent exists for an address element, the Finnish version will be returned.

The Form of address determines which address elements are used in the returned address. For the Finland dataset, the
street, locality and municipality elements vary according to the Form of address.

For instructions on how to change the Form of address in QuickAddress products, see the chapter "Using This Data" on
page 7.

Default Address Format

The default Finland address format is the same in either Form of address. It normally consists of two lines: the top line
containing the street name, followed by the building number; the bottom line containing the postal code, followed by the
locality name. The locality name is in upper case. By default, all other address elements are in mixed case.

For example:

Selim Lindqvistin kuja 1
00370 HELSINKI
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Using This Data
This chapter provides search tips and other product-specific information when using Pro or Pro Web.

These searches are accurate at the time of data release. However, search results may differ depending on the data
release you are using.

With Pro

Forms of Address

Forms of address are referred to as Country Views in Pro version 6 and earlier.

The Finland dataset contains different Forms of address, as described on page 6. The default layout will return addresses
in the default Form of address. If you want to return addresses in a different Form you must set up additional address
layouts. You can either use the Configuration Editor or manually edit the configuration files.

Using the Configuration Editor

You can add a new layout in the Configuration Editor with the following steps:

1. In the Configuration Editor Layout Manager, double-click on Finland. This expands the list of layouts that are set up.

2. Click on the New layout button on the toolbar. Alternatively, from the Layout menu, click New, or right-click Finland and
choose New from the menu.

A dialog opens listing the available Forms of address.

3. Select the Form of address you want to use and click OK. The new layout is added to the bottom of the layout list.

4. Rename the new layout. For example, if you added a layout based on the Swedish-language Form, you might rename
the layout "Swedish". You can rename the layout at any time by right-clicking it in the list, and selecting Rename from
the menu.

5. You can assign a hotkey for the new layout. When Pro is minimised, using a layout-specific hotkey will pop up the
program and automatically select that layout.

To assign a hotkey, click on the Hotkey field in the Layout Properties pane and press the keys you want to assign. For
example, if you have added a Swedish-language layout, click in the Hotkey field and press CTRL + W. When Pro is
minimised, this hotkey pops up Pro in the your Swedish-language layout.

It is recommended that you choose a hotkey not already in use by Pro (see the "Available Keystrokes" topic in the
Pro Help). You should also avoid common hotkeys, for example, CTRL + A. which in many Windows applications
means "Select All".For more information about hotkeys, see the Configuration Editor Help.

6. Save the changes you have made in Configuration Editor by clicking the Save button in the toolbar, or clicking Save
from the File menu, or pressing CTRL + S.

7. Close the Configuration Editor. The changes you have made will not take effect until you have closed and restarted Pro.

You can change the current layout in Pro Plug & Go by clicking Select Layout… from the View menu or pressing CTRL + L.
The Select Layout dialog opens. Choose the required layout from the list.

You can change the layout at any stage of your search. To view a returned address in a different layout, simply click Select
Layout… from the View menu, or press CTRL + L, and click the layout.
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If you drag the Select Layout dialog to the side of Pro, you can preview the changes in the final returned address as you
browse different layouts.

Editing the Configuration Files

To manually set up an output address layout in your Pro configuration files you will need to use the CDFVariaton keyword
with the number of the Form of address as listed in the table on page 6. For example, to set a Finland datamapping with
the identifier FIN to use the Swedish-language Form you would add the following setting to your layout:

FINCDFVariation=2

For more information see the configuration section of your product documentation.

Search Examples: Typedown

The following table provides a list of these example search types:

l Full address known;

l Postal code not known;

l PO Box number known;

l Swedish language address known.

Search type Example

Full address known 1. Enter the postal code, 71480, and press Enter.

2. Enter the first three letters of the street name, kar, and press Enter. In this
example kar is enough to uniquely identify Karhumäentie.

3. Enter the premises number, 33, and press Enter.

4. The correct address is returned:

Karhumäentie 33
71480 KURKIMÄKI

Postal code not known 1. Enter the location, veikkaala, and press Enter.

2. Enter the first two letters of the street name, ri, and press Enter. In this
example ri is enough to uniquely identify Riihentie.

3. Enter the premises number, 6, and press Enter.

4. The correct address is returned:

Riihentie 6
66520 VEIKKAALA

PO box number known 1. Enter the postal code, 33401, and press Enter.

2. Enter the PO Box number, 12, and press Enter.

3. The correct address is returned:

PL 12
33401 TAMPERE
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Search type Example

Swedish language address
known

In this example you are searching for the following Swedish language address:

Nybrovägen 44
64300 LAPPFJÄRD

1. Enter the postal code, 64300, and press Enter. Note that the results area
shows Lapväärtti, the Finnish name for Lappfjärd.

2. Enter the first three letters of the street name, nyb, and press Enter. In this
example nyb is enough to uniquely identify Uudensillantie. Note that the default
language (Finnish) is always used in the picklist.

3. Enter the premises number, 44, and press Enter.

4. The correct address is returned, according to the layout selected. The default
layout will return the Finnish address:

Uudensillantie 44
64300 LAPVÄÄRTTI

Search Examples: Single Line

The following table provides a list of these example search types:

l Full address known;

l Postal code not known;

l Only street name known;

l Character missing from address;

l Address contains spelling mistake;

l Swedish language address known;

l Incomplete address element (partial);

l Incomplete address element (tagged).

Search type Explanation

Full address known Enter the street name and premises number followed by the postal code:

antuntie 35,65280

The correct address is returned:

Antuntie 35
65280 VAASA

Postal code not known If the postal code is not known, enter the premises number and street name
followed by the locality:

jaanintie 26,turku

The correct address is returned:

Jaanintie 26
20540 TURKU
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Search type Explanation

Only street name known If only the street name is known, entering it returns a picklist fromwhich the
correct one can be selected.

Enter Helsingintie to view a list of every street with that name in the country.

Character missing from address If a character is missing from the address the unknown character can be
replaced with a question mark.

Enter In?intie 101,30100 and the correct address is returned:

Inkintie 101
30100 FORSSA

Address contains spelling mistake Entering an address that contains one or more spelling errors can still return
the correct address.

For example, entering Omemukaja 4,02750 will still return the correct
address:

Omenakuja 4
02750 ESPOO

Swedish address known In this example you are searching on a full Swedish language address:

saragatan 11,karis,10300

The correct address is returned, according to the selected layout. The default
layout will return the Finnish address:

Saarankatu 11
10300 KARJAA

Incomplete address element (partial) If you only have partial address information, you can replace the remainder of
an address element with an asterisk.

Entering ratihuoneenkatu,ha* will display a picklist of streets called
Ratihuoneenkatu in all places beginning "Ha…".

Incomplete address element (tagged) Sometimes it is helpful to tag a part of the search string to let Pro know which
part of the address it is. For a list of available search constraints, see below.

Searching on helsing*@l tells Pro to display a picklist of localities that begin
with "Helsing...".

Search Constraints

The following search constraints can be used to restrict searches when using the Single Line search engine in Pro.

Constraint Elements Restricted to Example

@L Municipality, locality Saar*@L

@S Street Helf*@S

@X Postal code 12170@x

With Pro Web
The Finland dataset contains different Forms of address, as described on page 6. Pro Web integrations can be configured
to use address elements relating to any Form of address. Refer to your Pro Web documentation for configuration
instructions.

Details of how Forms of address can be configured are provided on page 7.
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Scenarios

The following table indicates the relevant search examples for each Pro Web scenario and search engine that supports
FIN address data.

Scenario Search engine For search examples, see:

Address Capture on the Intranet Single Line hierarchical Single Line search examples on page 9.

Address Capture on the Web Single Line flattened Single Line search examples on page 9.

Address Capture Single Line flattened Single Line search examples on page 9.

Single Line Single Line hierarchical Single Line search examples on page 9.

Standard Typedown

Single Line hierarchical

Typedown examples on page 8.

Single Line search examples on page 9.

ActiveX Control Typedown

Single Line hierarchical

Typedown examples on page 8.

Single Line search examples on page 9.
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